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ASDMユーザインターフェイスについて
ASDMユーザインターフェイスは、ASAがサポートしているさまざまな機能に簡単にアクセ
スできるように設計されています。ASDMユーザインターフェイスには次の要素があります。

•ファイル、ツール、ウィザード、およびヘルプにすぐにアクセスできるメニューバー。メ
ニュー項目の多くにはキーボードショートカットもあります。
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• ASDMの操作のためのツールバー。ツールバーから [Home]ペイン、[Configuration]ペイ
ン、および [Monitoring]ペインにアクセスできます。また、ヘルプの参照やペイン間のナ
ビゲーションもできます。

•ドッキング可能な左側の [Navigation]ペイン。[Configuration]ペインや [Monitoring]ペイン
内の移動に使用します。ヘッダーにある3つのボタンをそれぞれクリックすると、ペイン
の最大化または復元、移動可能なフローティングペインへの変更、ペインの非表示化、ま

たはペインを閉じることができます。[Configuration]ペインおよび [Monitoring]ペインにア
クセスするには、次のいずれかを実行します。

•アプリケーションウィンドウの左端にある左側の [Navigation]ペインのリンクをク
リックします。選択した [Content]ペインのタイトルバーにパスが表示されます
（[Configuration] > [Device Setup] > [Startup Wizard]など）。

•正確なパスがわかっている場合、左側の [Navigation]ペインでリンクをクリックしな
くても、アプリケーションウィンドウの右側にある [Content]ペインのタイトルバー
に直接入力できます。

•左側の [Navigation]ペインを非表示/表示できる [Content]ペインの右端にある [maximize and
restore]ボタン。

•ドッキング可能な [Device List]ペイン。ASDMからアクセスできるデバイスのリストを表
示します。ヘッダーにある3つのボタンをそれぞれクリックすると、ペインの最大化また
は復元、移動可能なフローティングペインへの変更、ペインの非表示化、またはペインを

閉じることができます。

•時間、接続ステータス、ユーザ、メモリステータス、実行コンフィギュレーションステー
タス、権限レベル、および SSLステータスをアプリケーションウィンドウの下部に表示
するステータスバー。

•左側の [Navigation]ペイン。アクセスルール、NATルール、AAAルール、フィルタルー
ル、およびサービスルールの作成時にルールテーブルで使用できるさまざまなオブジェ

クトを表示します。ペイン内のタブタイトルは、表示している機能に応じて変わります。

また、このペインには ASDM Assistantが表示されます。

次の図に、ASDMユーザインターフェイスの要素を示します。
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図 1 : ASDMユーザインターフェイス
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ツールヒントが、[Wizards]、[Configuration]ペイン、[Monitoring]ペイン、ステータスバーを
含む、GUIのさまざまな部分に追加されています。ツールヒントを表示するには、マウスを
ステータスバーにあるアイコンなど、特定のユーザインターフェイス要素の上に置きます。

（注）

ASDMユーザインターフェイスのナビゲーション
ASDMユーザインターフェイスを効率的に移動するために、前の項で説明したメニュー、ツー
ルバー、ドッキング可能ペイン、および左側と右側の [Navigation]ペインを組み合わせて使用
できます。使用できる機能は、[Device List]ペインの下のボタンリストに表示されます。リス
ト例には、次の機能ボタンが入っている場合があります。

• Device Setup

• Firewall

• Botnet Traffic Filter

• Remote Access VPN

• Site to Site VPN

• Device Management

表示される機能ボタンのリストは、購入したライセンス機能に基づいて表示されます。コン

フィギュレーションビューまたはモニタリングビューの選択した機能の最初のペインにアク

セスするには、それぞれのボタンをクリックします。ホームビューでは、機能ボタンは使用で

きません。

機能ボタンの表示を変える場合は、次の手順を実行します。

手順

ステップ 1 最後の機能ボタンの下にあるドロップダウンリストボタンを選択して、コンテキストメニュー
を表示します。

ステップ 2 次のいずれかのオプションを選択します。

•表示するボタンを増やすには、[Show More Buttons]をクリックします。

•表示するボタンを減らすには、[Show Fewer Buttons]をクリックします。

•ボタンを追加または削除するには、[Add or Remove Buttons]をクリックし、表示されたリ
ストから追加または削除するボタンをクリックします。

• [Option]を選択すると [Option]ダイアログボックスが表示され、ボタンのリストが現在の
順序で表示されます。次のいずれかを選択します。

•リスト内のボタンを上に移動するには、[Move Up]をクリックします。
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•リスト内のボタンを下に移動するには、[Move Down]をクリックします。

•リスト内の項目の順序をデフォルト設定に戻すには、[Reset]をクリックします。

ステップ 3 [OK]をクリックして設定を保存し、ダイアログボックスを閉じます。

メニュー
ASDMの各メニューには、マウスまたはキーボードを使用してアクセスできます。

[File]メニュー
[File]メニューでは、ASAのコンフィギュレーションを管理できます。

説明[File]メニュー項目

実行コンフィギュレーションのコピーをASDMにロードしま
す。

Refresh ASDM with the
Running Configuration on the
Device

コンフィギュレーションを工場出荷時のデフォルトに復元し

ます。

Reset Device to the Factory
Default Configuration

現在の実行コンフィギュレーションを新しいウィンドウに表

示します。

ShowRunningConfiguration in
New Window

実行コンフィギュレーションのコピーをフラッシュメモリに

書き込みます。

Save Running Configuration to
Flash

現在の実行コンフィギュレーションファイルのコピーをTFTP
サーバに保存します。

Save Running Configuration to
TFTP Server

プライマリ装置の実行コンフィギュレーションファイルのコ

ピーを、フェールオーバースタンバイ装置の実行コンフィ

ギュレーションに送信します。

Save Running Configuration to
Standby Unit

内部ログバッファをフラッシュメモリに保存します。Save Internal Log Buffer to
Flash

モジュールに対して行った、ASA Firepowerモジュールポリ
シーへの設定変更を保存します。このオプションは、ASA
Firepowerモジュールをインストールして、ASDMで管理する
ときにのみ使用できます。

Deploy Firepower Changes
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説明[File]メニュー項目

現在のページを印刷します。ルールを印刷する場合、ページ

を横方向にすることをお勧めします。Internet Explorerの場合
は、署名付きアプレットを最初に承認した時点で印刷権限が

与えられています。

Print

ローカル ASDMイメージを削除します。ASDMに接続する
と、ASDMによりイメージがローカルにダウンロードされま
す。

Clear ASDM Cache

新しいパスワードを定義した後に、それとは異なる既存のパ

スワードがまだ残っている場合は、パスワードキャッシュを

削除します。

Clear ASDM Password Cache

syslogメッセージバッファを空にします。Clear Internal Log Buffer

ASDMを閉じます。終了

[View]メニュー
[View]メニューでは、ASDMユーザインターフェイスのさまざまな部分を表示できます。現
在のビューに応じた特定の項目が表示されます。現在のビューに表示できない項目は選択でき

ません。

説明[View]メニュー項目

ホームビューを表示します。ホーム

コンフィギュレーションビューを表示します。設定

モニタリングビューを表示します。モニタリング

ドッキング可能なペインにデバイスのリスト

を表示します。

Device List

コンフィギュレーションビューおよびモニタ

リングビューで [Navigation]ペインを表示ま
たは非表示にします。

ナビゲーション

タスクに応じたASDMの使用方法のヘルプを
検索し、見つけます。

ASDM Assistant
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説明[View]メニュー項目

ホームビューで [Latest ASDMSyslogMessages]
ペインを表示または非表示にします。このペ

インは、ホームビューでのみ使用できます。

最新のリリースにアップグレードするための

メモリが不足している場合は、syslogメッセー
ジ%ASA-1-211004が生成され、インストール
されているメモリ、および必要なメモリが示

されます。このメッセージは、メモリがアッ

プグレードされるまで、24時間ごとに再表示
されます。

Latest ASDM Syslog Messages

[Addresses]ペインを表示または非表示にしま
す。[Addresses]ペインは、コンフィギュレー
ションビューの [AccessRules]、[NATRules]、
[Service Policy Rules]、[AAA Rules]、および
[Filter Rules]ペインでのみ使用できます。

Addresses

[Services]ペインを表示または非表示にしま
す。[Services]ペインは、コンフィギュレー
ションビューの [AccessRules]、[NATRules]、
[Service Policy Rules]、[AAA Rules]、および
[Filter Rules]ペインでのみ使用できます。

Services

[Time Ranges]ペインを表示または非表示にし
ます。[Time Ranges]ペインは、コンフィギュ
レーションビューの [Access Rules]、[Service
Policy Rules]、[AAA Rules]、および [Filter
Rules]ペインでのみ使用できます。

時間範囲

マルチペイン画面で次のペインを強調表示し

ます。たとえば、[Service Policies Rules]ペイ
ンからその隣の [Address]ペインに移動しま
す。

Select Next Pane

マルチペイン画面で前のペインを強調表示し

ます。

Select Previous Pane

前のペインに戻ります。Back

以前に表示した次のペインに移動します。Forward

機能やASDMAssistantなどの項目を検索しま
す。

Find in ASDM

レイアウトをデフォルトのコンフィギュレー

ションに戻します。

Reset Layout
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説明[View]メニュー項目

画面のフォントと色をMicrosoft Office設定に
変更します。

Office Look and Feel

[Tools]メニュー
[Tools]メニューは、ASDMで使用できる次の一連のツールを提供します。

説明[Tools]メニュー項目

コマンドを ASAに送信して結果を表示しま
す。

Command Line Interface

ASDMに無視されたサポート対象外のコマン
ドを表示します。

Show Commands Ignored by ASDM on Device

指定した送信元アドレスとインターフェイス

から宛先まで、パケットをトレースします。

プロトコルおよびポートをデータタイプに関

わりなく指定でき、そこで実行された処理の

詳細データを含むパケットの一部始終を表示

できます。詳細については、ファイアウォー

ルの設定ガイドを参照してください。

Packet Tracer

ASAおよび関係する通信リンクのコンフィギュ
レーションや動作を検証し、他のネットワー

クデバイスの基本的なテストを実行します。

詳細については、ファイアウォールの設定ガ

イドを参照してください。

ping

パケットが宛先に到着するまでのルートを判

断します。詳細については、ファイアウォー

ルの設定ガイドを参照してください。

traceroute

フラッシュメモリに保存されたファイルを表

示、移動、コピー、および削除します。また、

フラッシュメモリにディレクトリを作成する

こともできます。また、TFTP、フラッシュメ
モリ、ローカル PCなどさまざまなファイル
システム間でファイル転送ができます。

ファイル管理

ウィザードを使用してASAソフトウェアおよ
びASDMソフトウェアをアップグレードしま
す。

Check for ASA/ASDM Updates
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説明[Tools]メニュー項目

ASAイメージ、ASDMイメージ、またはユー
ザ PCの他のイメージをフラッシュメモリに
アップロードします。

Upgrade Software from Local Computer

現在実行中のものよりも古いASAイメージを
ロードします。

Downgrade Software

ASAのコンフィギュレーション、CiscoSecure
Desktopイメージ、および SSL VPN Clientイ
メージおよびプロファイルをバックアップし

ます。

Backup Configurations

ASAのコンフィギュレーション、CiscoSecure
Desktopイメージ、および SSL VPN Clientイ
メージおよびプロファイルを復元します。

Restore Configurations

ASDMを再起動し、保存したコンフィギュレー
ションをメモリにリロードします。

System Reload

管理者が、クライアントレス SSLVPNユーザ
にアラートメッセージを送信できるようにし

ます。詳細については、VPN構成ガイドを参
照してください。

Administrator’s Alert to Clientless SSL VPN
Users
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説明[Tools]メニュー項目

8.3以降に移行する場合、ASAは名前付きネッ
トワークオブジェクトを作成して、一部の機

能のインライン IPアドレスを置き換えます。
名前付きオブジェクトに加えて、ASDMはコ
ンフィギュレーションで使用されているすべ

ての IPアドレスに対して名前なしオブジェク
トを自動的に作成します。これらの自動作成

されるオブジェクトは IPアドレスによっての
み識別され、名前がなく、プラットフォーム

設定に名前付きオブジェクトとしては存在し

ません。

移行の一部として名前付きオブジェクトをASA
が作成する場合、合致する非名前付き ASDM
専用オブジェクトは、名前付きオブジェクト

に置換されます。唯一の例外は、ネットワー

クオブジェクトグループの非名前付きオブ

ジェクトです。ネットワークオブジェクトグ

ループ内にある IPアドレスの名前付きオブ
ジェクトをASAが作成する場合、ASDMは非
名前付きオブジェクトを維持したまま、重複

したオブジェクトをASDMで作成します。こ
れらのオブジェクトをマージするには、[Tools]
> [Migrate Network Object Group Members]を選
択します。

詳細については、「Cisco ASA 5500 Migration
to Version 8.3 and Later」を参照してください。

Migrate Network Object Group Members

セッション間での特定のASDM機能の動作を
変更します。

Preferences

Javaコンソールを表示します。ASDM Java Console

[Wizards]メニュー
[Wizards]メニューにより、さまざまな機能を設定するウィザードを実行できます。

説明[Wizards]メニュー項目

ASAの初期設定を段階的にガイドします。Startup Wizard

さまざまなVPN設定用のウィザードが用意さ
れています。詳細については、VPN構成ガイ
ドを参照してください。

VPNWizard
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説明[Wizards]メニュー項目

フェールオーバーの設定が可能になります：

VPNクラスタロードバランシングまたはASA
上の ASAクラスタリング

High Availability and Scalability Wizard

ASA上で、IP電話などのユニファイドコミュ
ニケーション機能の設定が可能になります。

詳細については、ファイアウォールの設定ガ

イドを参照してください。

Unified Communication Wizard

Java 7 Update 51以降を使用する場合、ASDM
ランチャには信頼できる証明書が必要です。

証明書の要件は、自己署名付きの ID証明書を
インストールすることによって簡単に満たす

ことができます。このウィザードを使用して

証明書をインストールするまでは、Java Web
Startを使用してASDMを起動することができ
ます。詳細については、

http://www.cisco.com/go/asdm-certificateを参照
してください。

ASDM Identity Certificate Wizard

ASA上で、パケットキャプチャの設定が可能
になります。このウィザードは、入出力イン

ターフェイスのそれぞれでパケットキャプチャ

を1回実行します。キャプチャの実行後、キャ
プチャをコンピュータに保存し、パケットア

ナライザを使用してキャプチャを調査および

分析できます。

Packet Capture Wizard

[Window]メニュー
[Window]メニューを使用して、ASDMのウィンドウ間を移動できます。アクティブなウィン
ドウが選択されたウィンドウとして表示されます。

[Help]メニュー
[Help]メニューでは、オンラインヘルプへのリンクの他に、ASDMと ASAの情報も提供され
ます。
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説明[Help]メニュー項目

新しいブラウザウィンドウが開いてASDMの
オンラインヘルプが表示されます。ASDMで
ASAFirepowerモジュールを管理している場合
は、この項目に [ASDMHelp Topics]というラ
ベルが表示されます。

Help Topics

新しいブラウザウィンドウが開いて、ASA
Firepowerモジュールのオンラインヘルプが表
示されます。この項目は、ASDMでモジュー
ルをインストールして管理している場合にだ

け使用できます。

ASA FirePOWER Help Topics

表示されている画面に関する状況依存ヘルプ

が開きます。または、ツールバーの [? Help]
ボタンをクリックすることもできます。

Help for Current Screen

Cisco.comにある最新バージョンの [ASDM
release notes]を開きます。リリースノートに
は、ASDMのソフトウェアとハードウェア要
件の最新情報、およびソフトウェア変更に関

する最新情報が記載されています。

Release Notes

入手可能なすべての製品マニュアルへのリン

クを含むCisco.com上のドキュメントが開きま
す。

Cisco ASA Series Documentation

Cisco.comからダウンロード可能なコンテンツ
を検索でき、特定のタスクの実行に関する詳

細がわかる ASDM Assistantを開きます。

ASDM Assistant

ソフトウェアバージョン、ハードウェア構成、

スタートアップ時にロードされるコンフィギュ

レーションファイルやソフトウェアイメージ

など、ASAに関する情報を表示します。これ
らはトラブルシューティングの際に役立つ情

報です。

Cisco Adaptive Security Appliance (ASA)につ
いて

ソフトウェアバージョン、ホスト名、権限レ

ベル、オペレーティングシステム、デバイス

タイプ、Javaのバージョンなど、ASDMに関
する情報を表示します。

About Cisco ASDM
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ツールバー
メニューの下にあるツールバーから、ホームビュー、コンフィギュレーションビュー、およ

びモニタリングビューにアクセスできます。また、マルチコンテキストモードでシステムと

セキュリティコンテキストを選択したり、ナビゲーションおよびその他よく使用する機能を実

行できます。

説明ツールバーボタン

インターフェイスのステータス、実行中のバージョン、ライセンス情

報、パフォーマンスなど、ASAの重要な情報を表示できる [Home]ペ
インを表示します。マルチモードの場合、[Home]ペインはありませ
ん。

ホーム

ASAを設定します。左側の [Navigation]ペインの機能ボタンをクリッ
クして機能を設定します。

設定

ASAをモニタします。左側の [Navigation]ペインの機能ボタンをク
リックして、さまざまな要素をモニタします。

モニタリング

書き込みアクセスが可能なコンテキストに限り、実行コンフィギュ

レーションをスタートアップコンフィギュレーションとして保存し

ます。

デバイス上に ASA FirePOWERモジュールがインストールされてお
り、それをASDM経由で設定している場合は、このボタンに [Deploy]
ボタンに置き換えられます。

Save

デバイス上に ASA FirePOWERモジュールがインストールされてお
り、ASDMを経由で設定してる場合は、[Deploy] ボタンは [Save] ボ
タンを置き換え、次のオプションを含みます。

• [Deploy FirePOWER Changes]：モジュールに対する ASA
FirePOWERモジュールポリシーへの設定変更を保存します。

• [Save Running Configuration to Flash]：ASA実行コンフィギュレー
ションのコピーをフラッシュメモリに書き込みます。これは、

ASA FirePOWERモジュールを含まないデバイスの [Save]ボタン
と同等です。

展開

現在の実行コンフィギュレーションでASDMをリフレッシュします。
ただし、モニタリングペインのグラフはリフレッシュしません。

更新（Refresh]

直前に表示した ASDMのペインに戻ります。戻る（Back）

直前に表示した ASDMのペインに進みます。Forward

その時点で表示されている画面の状況依存ヘルプを表示します。Help

ASDMグラフィカルユーザインターフェイス
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説明ツールバーボタン

ASDM内で機能を検索します。検索機能は、各ペインのタイトルをす
べて検索して一致項目を表示します。ハイパーリンクをクリックする

と、該当ペインがただちに表示されます。[Back]または [Forward]を
クリックすると、検出した2つのペインをすばやく切り替えることが
できます。

検索（Search）

ASDM Assistant
ASDM Assistantでは、タスクに応じた ASDMの使用方法のヘルプを検索し、表示できます。
この機能は、シングルコンテキストとシステムコンテキストのルーテッドモードおよびトラ

ンスペアレントモードで使用できます。

[View] > [ASDMAssistant] > [How Do I?]の順に選択するか、メニューバーの [Look For]フィー
ルドから検索リクエストを入力して情報にアクセスします。[Find]ドロップダウンリストから
[How Do I?]を選択すると、検索が開始します。

ASDM Assistantを使用するには、次の手順を実行します。

手順

ステップ 1 [View] > [ASDM Assistant]を選択します。

[ASDM Assistant]ペインが表示されます。

ステップ 2 [Search]フィールドに検索する情報を入力して [Go]をクリックします。

要求された情報が [Search Results]ペインに表示されます。

ステップ 3 [Search Results]領域および [Features]領域に表示される任意のリンクをクリックし、詳細情報
を入手します。

ステータスバー
ステータスバーは ADSMウィンドウの下部に表示されます。次の表に、左から右に表示され
る領域を示します。

説明エリア

コンフィギュレーションのステータス

（「Device configuration loaded successfully.」な
ど）。

Status（ステータス）

ASDMグラフィカルユーザインターフェイス
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説明エリア

フェールオーバー装置のステータスで、アク

ティブまたはスタンバイのいずれか。

フェールオーバー

ASDMユーザのユーザ名。ユーザ名なしでロ
グインした場合、ユーザ名は「admin」です。

ユーザ名（User Name）

ASDMユーザの特権。User Privilege

アイコンをクリックすると、ASDMで処理さ
れなかったコンフィギュレーションのコマン

ドのリストが表示されます。これらのコマン

ドはコンフィギュレーションから削除されま

せん。

Commands Ignored by ASDM

ASDMの ASAとの接続ステータス。Connection to Device

syslog接続が動作しており、ASAが監視され
ています。

Syslog Connection

ASDMへの接続に SSLを使用し、安全である
ことを示します。

SSL Secure

ASAに設定された時刻。時刻

Connection to Device
ASDMは ASAとの接続を常に維持し、[Monitoring]ペインおよび [Home]ペインのデータを最
新に保ちます。このダイアログボックスに接続ステータスが表示されます。コンフィギュレー

ションを変更する場合、変更している間 ASDMは接続をもう一つ開き、変更が終わるとその
接続を閉じますが、このダイアログボックスには 2つ目の接続は表示されません。

Device List
[Device List]はドッキング可能なペインです。ヘッダーにある 3つのボタンをそれぞれクリッ
クすると、ペインの最大化または復元、移動可能なフローティングペインへの変更、ペインの

非表示化、またはペインを閉じることができます。このペインはホーム、コンフィギュレー

ション、モニタリング、およびシステムの各ビューで使用できます。このペインを使用して、

別のデバイスに切り替えたり、システムとコンテキスト間で切り替えたりすることができます

が、現在実行中のものと同じバージョンの ASDMがそのデバイスでも動作している必要があ
ります。ペインを完全に表示するには、少なくとも2つのデバイスがリストに表示されている
必要があります。このペインは、シングルコンテキスト、マルチコンテキストおよびシステ

ムコンテキストのルーテッドモードおよびトランスペアレントモードで使用できます。

このペインを使用して別のデバイスに接続するには、次の手順を実行します。

ASDMグラフィカルユーザインターフェイス
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手順

ステップ 1 [Add]をクリックしてリストに別のデバイスを追加します。

[Add Device]ダイアログボックスが表示されます。

ステップ 2 デバイス名またはデバイスの IPアドレスを入力し、[OK]をクリックします。

ステップ 3 リストから選択したデバイスを削除するには、[Delete]をクリックします。

ステップ 4 [Connect]をクリックして別のデバイスに接続します。

[Enter Network Password]ダイアログボックスが表示されます。

ステップ 5 ユーザ名とパスワードを該当するフィールドに入力し、[Login]をクリックします。

共通ボタン
多くの ASDMペインには、次の表に示すボタンが含まれています。目的の作業を完了するに
は、該当するボタンをクリックします。

説明ボタン

ASDMでの変更内容をASAに送信し、実行コ
ンフィギュレーションに適用します。

適用

実行コンフィギュレーションのコピーをフラッ

シュメモリに書き込みます。

Save

変更内容を破棄して、変更前、または [Refresh]
や [Apply]を最後にクリックした時点の表示情
報に戻します。[Reset]をクリックした後、
[Refresh]をクリックして、現在の実行コンフィ
ギュレーションの情報が表示されていること

を確認します。

Reset

選択した設定をクリアしてデフォルト設定に

戻します。

Restore Default

変更内容を破棄して、前のペインに戻ります。キャンセル

機能について読み取り専用の統計情報を表示

します。

Enable

開いているダイアログボックスを閉じます。Close

フィールドから情報を削除します。または、

チェックボックスをオフにします。

Clear

ASDMグラフィカルユーザインターフェイス
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説明ボタン

前のペインに戻ります。Back

次のペインに移動します。Forward

選択したペインまたはダイアログボックスを

表示します。

Help

キーボードショートカット
キーボードを使用して ASDMユーザインターフェイスをナビゲートできます。

次の表に、ASDMユーザインターフェイスの 3つの主要な領域間を移動するために使用可能
なキーボードショートカットの一覧を示します。

表 1 :メインウィンドウ内のキーボードショートカット

MacOSWindows/Linux表示対象

Shift+Command+HCtrl+H[Home]ペイン

Shift+Command+GCtrl+G[Configuration]ペイン

Shift+Command+MCtrl+M[Monitoring]ペイン

Command+?F1Help

Command+[Alt+左矢印戻る（Back）

Command+]Alt+右矢印Forward

Command+RF5表示のリフレッシュ

Command+XCtrl+XCut

Command+CCtrl+Cコピー（Copy）

Command+VCtrl+VPaste

Command+SCtrl+Sコンフィギュレーションの保

存

—Shift+F10ポップアップメニュー

Command+WAlt+F4セカンダリウィンドウを閉じ

る

Command+FCtrl+FFind

ASDMグラフィカルユーザインターフェイス
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MacOSWindows/Linux表示対象

Command+QAlt+F4終了

Ctril+Shiftまたは
Ctrl+Shift+Tab

Ctrl_ShiftまたはCtrl+Shift+Tabテーブルまたはテキスト領域

の終了

次に表に、ペイン内部のナビゲーションに使用可能なキーボードショートカットの一覧を示し

ます。

表 2 :ペイン内のキーボードショートカット

キーフォーカスの移動先

タブ次のフィールド

Shift+Tab前のフィールド

Ctrl+Tab次のフィールド（テーブル内にフォーカスが

ある場合）

Shift+Ctrl+Tab前のフィールド（テーブル内にフォーカスが

ある場合）

右矢印次のタブ（タブにフォーカスがある場合）

左矢印前のタブ（タブにフォーカスがある場合）

タブテーブル内の次のセル

Shift+Tabテーブル内の前のセル

F6次のペイン（複数のペインが表示されている

場合）

Shift+F6前のペイン（複数のペインが表示されている

場合）

次の表に、Log Viewerで使用可能なキーボードショートカットの一覧を示します。

表 3 :ログビューアのキーボードショートカット

MacOSWindows/Linux目的

Command+Ctrl+UReal-Time Log Viewerの一時停
止および再開

Command+RF5ログバッファペインのリフ

レッシュ

Command+DeleteCtrl+DeleteClear Internal Log Buffer

ASDMグラフィカルユーザインターフェイス
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MacOSWindows/Linux目的

Command+CCtrl+C選択したログエントリのコ

ピー

Command+SCtrl+Sログの保存

Command+PCtrl+PPrint

Command+WAlt+F4セカンダリウィンドウを閉じ

る

次の表に、メニュー項目へのアクセスに使用可能なキーボードショートカットの一覧を示しま

す。

表 4 :メニュー項目にアクセスするためのキーボードショートカット

Windows/Linuxアクセス対象

Altメニューバー

右矢印次のメニュー

左矢印前のメニュー

下矢印次のメニューオプション

上矢印前のメニューオプション

Enter選択したメニューオプション

ASDMペインの検索機能
一部の ASDMペインには、多くの要素を持つテーブルが含まれています。特定のエントリを
簡単に検索および強調表示して編集するために、複数の ASDMペインには、これらのペイン
内のオブジェクトを検索できる検索機能が含まれています。

検索を実行する場合は、[Find]フィールドにフレーズを入力し、特定のペイン内のすべてのカ
ラムを検索できます。フレーズにはワイルドカード文字の「*」および「?」を含めることがで
きます。*は 1つ以上の文字と一致し、?は 1つの文字と一致します。[Find]フィールドの右に
ある上矢印と下矢印を使用して、次（上）または前（下）のフレーズの出現に移動します。

[Match Case]チェックボックスをオンにすると、入力した大文字および小文字に正確に一致す
るエントリを検索します。

たとえば、B*ton-L*と入力すると、次の一致が返されます。

Boston-LA, Boston-Lisbon, Boston-London

ASDMグラフィカルユーザインターフェイス
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Bo?tonと入力すると、次の一致が返されます。

Boston, Bolton

ルールリストの検索機能
ACLや ACEおよびその他のルールにはさまざまなタイプの多数の要素が含まれているため、
ルールを表示する任意のペインの検索機能では、他のペインの検索機能よりも対象を絞った検

索を実行できます。これには、アクセスルール、サービスポリシールール、ACL Manager、
ACLルールを一覧表示するその他のペイン、および NATルールも含まれます。

ルールリスト内で要素を検索するには、次の手順を実行します。

手順

ステップ 1 [Find]をクリックします。

ステップ 2 [Filter]フィールドで、ドロップダウンリストから次のオプションのいずれかを選択します。

検索可能な項目は、ルールタイプによって異なり、表の列に対応しています。複数のフィール

ドを使用する複雑な検索を作成する場合は、[Query]を選択します。

ステップ 3 [Query]を選択しなかった場合は、2番目のフィールドで、ドロップダウンリストから次のい
ずれかのオプションを選択します。

• [is]：検索文字列に対する完全一致を指定します。これは常にクエリのオプションです。

• [contains]：検索文字列の一部または全部を含む任意のルールに対する一致を指定します。

ステップ 4 3番目のフィールドに、検索する文字列を入力します。...をクリックすると、リストからオブ
ジェクトを選択できます。クエリを使用している場合は、[Define Query]をクリックします。

IPアドレスを検索する場合は、ASDMによって作成されたオブジェクトまたはグループであ
る限り、ネットワークオブジェクトまたはグループ内のアドレスに一致するものを取得できま

す。つまり、グループ名は DM_INLINEで始まります。検索機能は、ユーザが作成したオブ
ジェクト内の IPアドレスを検索できません。

ステップ 5 検索を実行するには、[Filter]をクリックします。

ビューが更新され、一致するルールのみが表示されます。ルール番号は、ルールリスト内の絶

対位置を確認できるように維持されます。

ステップ 6 [Clear]をクリックすると、フィルタが削除され、リスト全体が再度表示されます。

ステップ 7 完了したら、赤色の xをクリックして検索コントロールを閉じます。

ASDMグラフィカルユーザインターフェイス
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拡張スクリーンリーダサポートの有効化
デフォルトでは、Tabキーを押してペイン内を移動するときに、ラベルと説明はタブの移動先
から除外されます。JAWSのような一部のスクリーンリーダだけが、フォーカスのある画面オ
ブジェクトを読み取ります。拡張スクリーンリーダサポートをイネーブルにすると、ラベル

と説明にもタブを移動させることができます。

拡張スクリーンリーダサポートをイネーブルにするには、次の手順を実行します。

手順

ステップ 1 [Tools] > [Preferences]の順に選択します。

[Preferences]ダイアログボックスが表示されます。

ステップ 2 [General]タブの [Enable screen reader support]チェックボックスをオンにします。

ステップ 3 [OK]をクリックします。

ステップ 4 スクリーンリーダサポートをアクティブにするには、ASDMを再起動します。

整理用フォルダー
コンフィギュレーションビューおよびモニタリングビューのナビゲーションペインに含まれ

る一部のフォルダには、関連付けられたコンフィギュレーションペインやモニタリングペイ

ンがありません。これらのフォルダは、関連するコンフィギュレーションタスクやモニタリン

グタスクを整理するために使用します。これらのフォルダをクリックすると、右側の[Navigation]
ペインにサブ項目のリストが表示されます。サブ項目の名前をクリックするとその項目に移動

できます。

[Home]ペイン（シングルモードとコンテキスト）
ASDMの [Home]ペインでは、ASAに関する重要な情報を表示できます。[Home]ペインのス
テータス情報は10秒間隔で更新されます。このペインには通常、[DeviceDashboard]と [Firewall
Dashboard]の 2つのタブがあります。

IPSモジュール、CXモジュール、ASA Firepowerモジュールなどのハードウェアまたはソフト
ウェアモジュールがデバイスにインストールされている場合は、それ専用のタブが表示されま

す。

ASDMグラフィカルユーザインターフェイス
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[Device Dashboard]タブ
[Device Dashboard]タブでは、インターフェイスのステータス、実行中のバージョン、ライセ
ンス情報、パフォーマンスなど、ASAの重要な情報を一目で確認できます。

次の図に、[Device Dashboard]タブの要素を示します。

図 2 : [Device Dashboard]タブ

凡例

説明GUI要素

[Device Information]ペイン（23ページ）1

[Interface Status]ペイン（24ページ）2

[VPN Sessions]ペイン（24ページ）3

[Traffic Status]ペイン（25ページ）4

[System Resources Status]ペイン（25ページ）5

[Traffic Status]ペイン（25ページ）6

Device List（15ページ）—

ASDMグラフィカルユーザインターフェイス
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説明GUI要素

[Latest ASDM Syslog Messages]ペイン（25
ページ）

—

[Device Information]ペイン

[Device Information]ペインには、[General]タブと [License]タブというデバイス情報を表示する
2つのタブがあります。[General]タブでは、システムヘルスが一目でわかる [EnvironmentStatus]
ボタンにアクセスできます。

[General]タブ

このタブには、ASAに関する次の基本情報が表示されます。

• [Host name]：デバイスのホスト名を表示します。

• [ASAversion]：デバイス上で実行されているASAソフトウェアのバージョンを示します。

• [ASDMversion]：デバイス上で実行されているASDMソフトウェアのバージョンを表示し
ます。

• [Firewall mode]：デバイスが実行されているファイアウォールモードを表示します。

• [Total flash]：現在使用されている RAMの合計を表示します。

• [ASACluster Role]：クラスタリングが有効の場合に、この装置のロール（マスターまたは
スレーブ）を表示します。

• [Device uptime]：最後にソフトウェアをアップロードしてから、デバイスが動作している
時間を表示します。

• [Context mode]：デバイスが実行されているコンテキストモードを表示します。

• [Total Memory]：ASAにインストールされている DRAMを表示します。

• [Environment status]：システムヘルスを表示します。[General]タブの [Environment Status]
というラベルの右側にあるプラス記号（+）をクリックして、ハードウェア統計情報を表
示します。設置されている電源装置数の確認、ファンと電源モジュールの動作ステータス

の追跡、および CPUの温度とシステムの周囲温度の追跡を実行できます。

一般に、[Environment Status]ボタンでシステムヘルスが一目でわかります。システム内の
モニタ対象のすべてのハードウェアコンポーネントが正常な範囲内で動作している場合、

プラス記号（+）ボタンには [OK]が緑で表示されます。一方、ハードウェアシステム内
のコンポーネントが 1つでも正常な範囲外で動作している場合は、プラス記号（+）ボタ
ンが赤色の丸になってクリティカルステータスを示し、ハードウェアコンポーネントに

関してすぐに対処が必要であることを示します。

特定のハードウェアの統計情報に関する詳細については、そのデバイスの『ハードウェア

ガイド』を参照してください。
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最新リリースの ASAにアップグレードするにはメモリが不足している場合は、[Memory
Insufficient Warning]ダイアログボックスが表示されます。このダイアログボックスに表示され
る指示に従って、サポートされている方法でASAおよびASDMを継続して使用します。[OK]
をクリックして、このダイアログボックスを閉じます。

（注）

[License]タブ

このタブには、ライセンス機能のサブセットが表示されます。詳細なライセンス情報の表示ま

たは新しいアクティベーションキーの入力を行うには、[More Licenses]をクリックします。
[Configuration] > [Device Management] > [Licensing] > [Activation Key]ペインが表示されます。

[Cluster]タブ

このタブには、クラスタのインターフェイスモードおよびクラスタのステータスが表示されま

す。

仮想リソースタブ（ASAv）

このタブは、ASAによって使用されている仮想リソースを表示します。vCPUの数、RAM、
ASAのプロビジョニングの過不足が含まれます。

[Interface Status]ペイン

このペインには、各インターフェイスのステータスが表示されます。インターフェイスの行を

選択すると、入力および出力スループットが Kbps単位でテーブルの下に表示されます。

[VPN Sessions]ペイン

このペインには、VPNトンネルステータスが表示されます。[Details]をクリックすると、
[Monitoring] > [VPN] > [VPN Statistics] > [Sessions]ペインに移動します。

[Failover Status]ペイン

このペインには、フェールオーバーステータスが表示されます。

[Configure]をクリックして、HighAvailability and ScalabilityWizardを起動します。このウィザー
ドを完了すると、フェールオーバーコンフィギュレーションステータス（[Active/Active]また
は [Active/Standby]）が表示されます。
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フェールオーバーが設定されている場合は、[Details]をクリックすると、[Monitoring]>[Properties]
> [Failover] > [Status]ペインが開きます。

[System Resources Status]ペイン

このペインには、CPUおよびメモリの使用状況に関する統計情報が表示されます。

[Traffic Status]ペイン

このペインには、インターフェイス全体の接続数/秒と、最も遅いセキュリティインターフェ
イスのトラフィックスループットのグラフが表示されます。

コンフィギュレーションにセキュリティレベルが最も低いインターフェイスが複数含まれてお

り、そのいずれかの名前が「outside」である場合、そのインターフェイスがトラフィックス
ループットのグラフに使用されます。それ以外の場合、ASDMはセキュリティレベルが最も
低いインターフェイスのアルファベット順のリストから最初のインターフェイスを選択しま

す。

[Latest ASDM Syslog Messages]ペイン

このペインには、ASAが生成した最新のシステムメッセージが 100個まで表示されます。ロ
ギングがディセーブルになっている場合は、[Enable Logging]をクリックしてイネーブルにし
ます。

次の図に、[Latest ASDM Syslog Messages]ペインの要素を示します。

図 3 : [Latest ASDM Syslog Messages]ペイン

凡例

説明GUI要素

ペインのサイズを変更するには、ディバイダ

を上または下にドラッグします。

1

ペインを展開します。ペインをデフォルトの

サイズに戻すには、二重の正方形のアイコン

をクリックします。

2
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説明GUI要素

フローティングペインを作成します。ペイン

をドッキングするには、ドッキングしたペイ

ンアイコンをクリックします。

3

自動非表示をイネーブルまたはディセーブル

にします。自動非表示がイネーブルな場合は、

左下隅にある [Latest ASDM Syslog Messages]
ボタンの上にカーソルを移動すると、ペイン

が表示されます。カーソルをペインから離す

と、ペインは非表示になります。

4

ペインを閉じます。ペインを表示するには、

[View Latest ASDM Syslog Messages]を選択し
ます。

5

右側にある緑のアイコンをクリックすると、

syslogメッセージの表示の更新を続行します。
6

右側にある赤いアイコンをクリックすると、

syslogメッセージの表示の更新を停止します。
7

右側にあるフィルタアイコンをクリックする

と、[Logging Filters]ペインが開きます。
8

•イベントを右クリックして [ClearContent]を選択すると、現在のメッセージを消去します。

•イベントを右クリックして [SaveContent]をクリックすると、現在のメッセージをPC上の
ファイルに保存します。

•イベントを右クリックして [Copy]を選択すると、現在の内容をコピーします。

•イベントを右クリックして [Color Settings]を選択すると、重大度に基づいて syslogメッ
セージの背景色と前景色を変更します。

[Firewall Dashboard]タブ
[FirewallDashboard]タブでは、ASAを通過するトラフィックに関する重要な情報を確認できま
す。このダッシュボードは、シングルコンテキストモードまたはマルチコンテキストモード

のどちらであるかにより異なります。マルチコンテキストモードでは、[Firewall Dashboard]
は各コンテキスト内に表示できます。

次の図に、[Firewall Dashboard]タブの要素の一部を示します。
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図 4 : [Firewall Dashboard]タブ

凡例

説明GUI要素

[Traffic Overview]ペイン（27ページ）1

[Top 10 Access Rules]ペイン（28ページ）2

[Top Usage Status]ペイン（28ページ）3

[Top Ten Protected Servers Under SYN Attack]ペ
イン（29ページ）

（表示なし）

[Top 200 Hosts]ペイン（29ページ）（表示なし）

[Top Botnet Traffic Filter Hits]ペイン（29ペー
ジ）

（表示なし）

[Traffic Overview]ペイン

デフォルトでは、イネーブルです。基本脅威検出をディセーブルにすると（を参照）、この領

域には [Enable]ボタンが表示されます。[Enable]ボタンを使用して基本脅威検出をディセーブ
ルにできます。実行時の統計情報には、表示専用の次の情報が含まれます。

•接続数と NAT変換数。
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•アクセスリストによる拒否およびアプリケーションインスペクションによってドロップ
されたパケット数/秒。

•ドロップパケット数/秒。これは、スキャン攻撃の一部として特定される場合と、不完全
なセッションとして検出される場合（TCP SYN攻撃やデータなし UDPセッション攻撃を
検出した場合など）があります。

[Top 10 Access Rules]ペイン

デフォルトでは、イネーブルです。アクセスルールの脅威検出統計情報をディセーブルにする

と（『ファイアウォールの設定ガイド』を参照）、この領域には [Enable]ボタンが表示されま
す。[Enable]ボタンを使用してアクセスルールの統計情報を有効にできます。

テーブルビューでは、リストからルールを選択して右クリックし、ポップアップメニュー項

目の [Show Rule]を表示できます。この項目を選択して [Access Rules]テーブルに移動し、テー
ブル内にあるそのルールを選択します。

[Top Usage Status]ペイン

デフォルトでは、ディセーブルです。このペインには、次の 4つのタブがあります。

• [Top 10 Services]：脅威検出サービス

• [Top 10 Sources]：脅威検出サービス

• [Top 10 Destinations]：脅威検出サービス

• [Top 10 Users]：アイデンティティファイアウォールサービス

最初の 3つのタブ（[Top 10 Services]、[Top 10 Sources]、および [Top 10 Destinations]）では、脅
威検出サービスに関する統計情報を提供します。各タブには、それぞれの脅威検出サービスを

イネーブルにする [Enable]ボタンがあります。『ファイアウォールの設定ガイド』に従って、
これらを有効にできます。

[Top 10 Services Enable]ボタンを使用すると、ポートとプロトコルの両方の統計情報がイネー
ブルになります（どちらも表示用にイネーブルにする必要があります）。[Top10Sources]ボタ
ンおよび [Top 10 Destinations Enable]ボタンを使用すると、ホストの統計情報がイネーブルに
なります。ホスト（送信元および宛先）の上位使用ステータス統計情報、およびポートとプロ

トコルが表示されます。

4番目のタブ [Top 10 Users]では、アイデンティティファイアウォールサービスに関する統計
情報を提供します。アイデンティティファイアウォールサービスでは、ユーザのアイデンティ

ティに基づくアクセスコントロールを提供します。送信元 IPアドレスではなくユーザ名とユー
ザグループ名に基づいてアクセスルールとセキュリティポリシーを設定できます。ASAは、
IPとユーザのマッピングデータベースにアクセスして、このサービスを提供します。

[Top 10 Users]タブは、次のいずれかを設定した場合のみ、データを表示します。

• Identity Firewallサービスコンフィギュレーション：Microsoft Active Directoryおよび Cisco
ActiveDirectory（AD）エージェンの追加コンポーネントの設定を含みます。IdentityFirewall
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サービスは、user-identity enableコマンド（デフォルトで有効）および user-accounting
statisticsコマンドを衣装して有効化されます。

• VPNユーザの認証、認可またはアカウンティングを行うために RADIUSサーバを使用す
る VPNコンフィギュレーション。

選択したオプションに応じて、[Top 10 Users]タブに、上位 10ユーザの受信した EPSパケッ
ト、送信した EPSパケット、および送信された攻撃に関する統計情報が表示されます。
（domain\user_nameとして表示される）各ユーザに関して、このタブには、そのユーザの平均
EPSパケット、現在の EPSパケット、トリガー、および合計イベント数が表示されます。

拡張統計情報を有効にすると、有効にする統計情報のタイプに応じて、ASAのパフォーマンス
が影響を受けます。ホストの統計情報をイネーブルにすると、パフォーマンスに大きな影響が

あります。トラフィックの負荷が高い場合は、このタイプの統計情報は一時的にイネーブルに

することを検討してください。ただし、ポートの統計情報をイネーブルにしても、それほど影

響はありません。

注意

[Top Ten Protected Servers Under SYN Attack]ペイン

デフォルトでは、ディセーブルです。この領域に表示されている [Enable]ボタンを使用して、
この機能を有効にできます。または、『ファイアウォール設定ガイド』に従って有効にするこ

ともできます。攻撃を受けて保護された上位 10サーバの統計情報が表示されます。

平均攻撃レートの場合、ASAはレート間隔（デフォルトは 30分）に対して 30秒ごとにデータ
をサンプリングします。

複数の攻撃者がいる場合は、「<various>」の後に最後の攻撃者の IPアドレスが表示されます。

[Detail]をクリックして、10台のサーバだけでなく、すべてのサーバ（最大 1000台）の統計情
報を表示します。履歴サンプリングデータを確認することもできます。ASAはレート間隔の
間に攻撃の数を 60回サンプリングするので、デフォルトの 30分間隔では、60秒ごとに統計情
報が収集されます。

[Top 200 Hosts]ペイン

デフォルトでは、ディセーブルです。ASAを介して接続中の上位200のホストを表示します。
ホストの各エントリには、ホストの IPアドレスと、ホストによって開始された接続の数が含
まれ、このエントリは120秒ごとにアップデートされます。この表示をイネーブルにするには
hpm topnenableコマンドを入力します。

[Top Botnet Traffic Filter Hits]ペイン

デフォルトでは、ディセーブルです。この領域には、ボットネットトラフィックフィルタを

設定するためのリンクが含まれています。上位 10個のボットネットサイト、ポート、および
感染ホストのレポートは、データのスナップショットを提供し、統計情報の収集開始以降の上

位 10項目に一致しない場合があります。IPアドレスを右クリックすると、whoisツールが起
動してボットネットサイトの詳細が表示されます。
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詳細については、『ボットネット設定ガイド』を参照してください。

[Cluster Dashboard]タブ
ASAクラスタリングをイネーブルにして、マスターユニットに接続している場合は、[Cluster
Dashboard]タブにクラスタのメンバーシップとリソース使用率の概要が表示されます。

• [Cluster Members]：クラスタを構成するメンバーの名前と基本情報（管理 IPアドレス、
バージョン、クラスタ内のロールなど）およびメンバーのヘルスステータス（環境ステー

タス、ヘルスステータス、およびリソース使用率）を表示します。
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マルチコンテキストモードでは、管理コンテキストに ASDMを
接続し、次に別のコンテキストに変更しても、リスト表示されて

いる管理 IPアドレスは現在のコンテキストの管理 IPアドレスに
変更されません。ASDMが現在接続されているメインクラスタの
IPアドレスを含む管理コンテキストの管理 IPアドレスを、引き
続き表示し続けます。

（注）

• [System Resource Status]：クラスタ全体のリソース使用率（CPUおよびメモリ）とトラ
フィックのグラフ（クラスタ全体およびデバイスごと）を表示します。

• [Traffic Status]：各タブには次のグラフがあります。

• [Connections Per Second]タブ

[Cluster Overal]：クラスタ全体の秒単位の接続数が表示されます。

[Per-Member Total]：各メンバーの秒単位の平均接続数が表示されます。

• [Throughput]タブ

[Cluster Overall]：クラスタ全体の総出力スループットが表示されます。

[Per-Member Throughput]：メンバーのスループットが、メンバーごとに 1行ずつ表示
されます。

• [Load Balancing]タブ

[Per-Member Percentage of Total Traffic]：メンバーが受信した総クラスタトラフィック
の割合が、メンバーごとに表示されます。

[Per-Member Locally Processed Traffic]：ローカルに処理されたトラフィックの割合が、
メンバーごとに表示されます。

• [Control Link Usage]タブ

[Per-Member Receival Capacity Utilization]：送信容量の使用率が、メンバーごとに表示
されます。

[Per-Member Transmittal Capacity Utilization]：受信容量の使用率が、メンバーごとに表
示されます。

[Cluster Firewall Dashboard]タブ
[Cluster FirewallDashboard]タブには、[FirewallDashboard]に表示される情報と同様のトラフィッ
クの概要および「topN」統計情報が表示されますが、クラスタ全体にわたる総計は表示されま
せん。
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[Content Security]タブ
[Content Security]タブでは、CSC（Content Security and Control）SSMに関する重要な情報を確
認できます。このペインは、CSCSSMで動作しているCSCソフトウェアがASAにインストー
ルされている場合のみ表示されます。

[Configuration] > [Trend Micro Content Security] > [CSC Setup]を選択して CSC SetupWizardを完
了していないと、[Home] > [Content Security]の下にあるペインにアクセスできません。代わり
にダイアログボックスが表示され、この場所からCSCSetupWizardに直接アクセスできます。

（注）

次の図に、[Content Security]タブの要素を示します。
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図 5 : [Content Security]タブ

凡例

説明GUI要素

[CSC SSM Information]ペイン。1

[Threat Summary]ペイン。CSC SSMにより検
出された脅威の集約データを表示します。ウ

イルス、スパイウェア、フィルタリングまた

はブロックされた URL、ブロックされたスパ
ム、ブロックされたファイル、損害制御サー

ビスなどがあります。

2

[System Resources Status]ペイン。3

[Email Scan]ペイン。グラフには、10秒間隔で
データが表示されます。

4

[Latest CSC Security Events]ペイン。5
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[Intrusion Prevention]タブ
[Intrusion Prevention]タブでは、IPSに関する重要な情報を確認できます。このタブは、ASAに
IPSモジュールがインストールされている場合にのみ表示されます。

IPSモジュールに接続するには、次の手順を実行します。

1. [Intrusion Prevention]タブをクリックします。

[Connecting to IPS]ダイアログボックスが表示されます。

2. IPアドレス、ポート、ユーザ名、およびパスワードを入力します。デフォルトの IPアド
レスとポートは192.168.1.2:443です。デフォルトのユーザ名およびパスワードは、ciscoと
ciscoです。

3. ログイン情報をローカル PCに保存するには、[Save IPS login information on local host]チェッ
クボックスをオンにします。

4. [Continue]をクリックします。

侵入防御に関する詳細については、『IPSクイックスタートガイド』を参照してください。

次の図に、[Intrusion Prevention]タブにある [Health Dashboard]タブの要素を示します。
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図 6 : [Intrusion Prevention]タブ（Health Dashboard）

凡例

説明GUI要素

[Sensor Information]ペイン。1

[Sensor Health]ペイン。2

[CPU, Memory, and Load]ペイン。3

[Interface Status]ペイン。4

[Licensing]ペイン。5

[ASA CX Status]タブ
[ASACXStatus]タブには、ASACXモジュールに関する重要な情報が表示されます。このタブ
は、ASAに ASA CXモジュールがインストールされている場合にのみ表示されます。
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[ASA Firepower Status]タブ
[ASA FirepowerStatus]タブには、このモジュールに関する情報が表示されます。この情報に
は、モデル、シリアル番号、ソフトウェアバージョンなどのモジュール情報と、アプリケー

ション名、アプリケーションステータス、データプレーンステータス、全体のステータスな

どのモジュールステータスが含まれます。モジュールが FireSIGHT Management Centerに登録
されている場合は、リンクをクリックしてアプリケーションを開き、詳細な分析やモジュール

の設定を行うことができます。

このタブは、ASA Firepowerモジュールがデバイスにインストールされている場合にのみ表示
されます。

FireSIGHT Management Centerではなく ASDMを使用して ASA Firepowerモジュールを管理し
ている場合は、追加のタブが表示されます。

• [ASAFirepowerDashboard]：ダッシュボードには、モジュールで実行中のソフトウェア、
製品のアップデート、ライセンシング、システムの負荷、ディスクの使用、システム時

間、およびインターフェイスのステータスについての概要情報が提示されます。

• [ASA FirepowerReporting]：レポート作成のページには、Webカテゴリ、ユーザ、送信
元、モジュールを通じてトラフィックが渡される宛先など、さまざまなモジュールの統計

に対して上位 10個のダッシュボードが提示されます。

[Home]ペイン（システム）
ASDMシステムの [Home]ペインでは、ASAに関する重要なステータス情報を表示できます。
ASDMシステムの [Home]ペインに表示される詳細のほとんどは、ASDMの他の場所でも参照
できますが、このペインではASAの動作状態を一目で確認できます。システムの [Home]ペイ
ンのステータス情報は 10秒間隔で更新されます。
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次の図に、システムの [Home]ペインの要素を示します。

図 7 :システムの [Home]ペイン

凡例

説明GUI要素

システムとコンテキストの選択。1

[Interface Status]ペイン。インターフェイスを
通過するトラフィックの総数を表示するには、

インターフェイスを選択します。

2

[Connection Status]ペイン。3

[CPU Status]ペイン。4

[Memory Status]ペイン。5
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ASDM設定の定義
特定の ASDM設定の動作を定義できます。

ASDMのさまざまな設定を変更するには、次の手順を実行します。

手順

ステップ 1 [Tools] > [Preferences]の順に選択します。

[General]、[Rules Table]、および [Syslog]の 3つのタブのある [Preferences]ダイアログボックス
が表示されます。

ステップ 2 設定を定義するには、これらのタブの1つをクリックします。[General]タブでは汎用プリファ
レンスを指定し、[Rules Table]タブでは [Rules]テーブルのプリファレンスを指定します。ま
た、[Syslog]タブでは、[Home]ペインに表示される syslogメッセージの外観を指定したり、
NetFlow関連の syslogメッセージの警告メッセージの表示をイネーブルにしたりできます。

ステップ 3 [General]タブでは、次の項目を指定します。

•スタートアップコンフィギュレーションと実行コンフィギュレーションが同期していない
ときに通知されるようにする場合は、[Warn that configuration in ASDM is out of sync with the
configuration in ASA]チェックボックスをオンにします。

•起動時に read-onlyユーザに対して次のメッセージを表示する場合は、[Show configuration
restrictionmessage to read-only user]チェックボックスをオンにします。このオプションは、
デフォルトでオンです。

“You are not allowed to modify the ASA configuration,
because you do not have sufficient privileges.”

•スレーブユニットに接続されたユーザに設定制限メッセージを表示するには、[Show
configuration restriction message on a slave unit in an ASA cluster]チェックボックスをオンに
します。

• ASDMを閉じるときに終了を確認するプロンプトが表示されるようにするには、[Confirm
before exiting from ]チェックボックスをオンにします。このオプションは、デフォルトで
オンです。

•スクリーンリーダーをイネーブルにするには、[Enable screen reader support (requires ASDM
restart)]チェックボックスをオンにします。このオプションをイネーブルにするには、
ASDMを再起動する必要があります。

• ASAメモリの最小空き容量が、ASDMアプリケーションの完全な機能を実行するには不
十分である場合に通知を受信するには、[Warn of insufficientASAmemorywhenASDM loads]
チェックボックスをオンにします。ASDMは、起動時にテキストバナーメッセージにメ
モリ警告を表示し、ASDMのタイトルバーテキストにメッセージを表示し、24時間ごと
に syslogアラートを送信します。
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• [Communications]領域で：

• ASDMによって生成される CLIコマンドを表示するには、[Preview commands before
sending them to the device]チェックボックスをオンにします。

• ASAに複数のコマンドを1つのグループとして送信するには、[Enable cumulative (batch)
CLI delivery]チェックボックスをオンにします。

• [MinimumConfiguration Sending Timeout]フィールドにタイムアウトメッセージの送信
設定の最短時間を秒単位で入力します。デフォルトは 60秒です。

• [Logging]領域で：

• Javaロギングを設定するには、[Enable logging to the ASDM Java console]チェックボッ
クスをオンにします。

•ドロップダウンリストから [Logging Level]を選択して、重大度を設定します。

• [PacketCaptureWizard]領域で、キャプチャされたパケットを表示するには、[NetworkSniffer
Application]に名前を入力するか、[Browse]をクリックしてファイルシステムで検索しま
す。

ステップ 4 [Rules Table]タブで、次の項目を指定します。

• [Display settings]では、[Rules]テーブルでのルールの表示方法を変更できます。

• Auto-Expand Prefix設定に基づいて自動展開されたネットワークおよびサービスオブ
ジェクトグループを表示するには、[Auto-expand network and service object groups with
specified prefix]チェックボックスをオンにします。

• [Auto-ExpandPrefix]フィールドに、表示するときに自動的に展開するネットワークお
よびサービスオブジェクトグループのプレフィックスを入力します。

•ネットワークおよびサービスオブジェクトグループのメンバーとそのグループ名を
[Rules]テーブルに表示するには、[Show members of network and service object groups]
チェックボックスをオンにします。チェックボックスがオフの場合は、グループ名だ

けが表示されます。

• [Limit Members To]フィールドに、表示するネットワークおよびサービスオブジェク
トグループの数を入力します。オブジェクトグループメンバーが表示されるときに

は、最初の n個のメンバーだけが表示されます。

• [Rules]テーブルにすべてのアクションを表示するには、[Show all actions for service
policy rules]チェックボックスをオンにします。オフの場合は、サマリーが表示されま
す。

• [Deployment Settings]では、[Rules]テーブルに変更内容を適用するときのASAの動作を設
定できます。

•新しいアクセスリストを適用するときにNATテーブルをクリアするには、[Issue“clear
xlate” command when deploying access lists]チェックボックスをオンにします。この設
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定により、ASAで設定されるアクセスリストが、すべての変換アドレスに対して確
実に適用されるようにします。

• [Access Rule Hit Count Settings]では、[Access Rules]テーブルのヒット数をアップデートす
る頻度を設定できます。ヒット数は、明示的なルールにだけ適用されます。暗黙的なルー

ルのヒット数は、[Access Rules]テーブルには表示されません。

• [Access Rules]テーブルでヒット数が自動的にアップデートされるようにするには、
[Update access rule hit counts automatically]チェックボックスをオンにします。

• [AccessRules]テーブルに、ヒット数カラムを更新する頻度を秒単位で指定します。有
効値の範囲は 10～ 86400秒です。

ステップ 5 [Syslogl]タブでは、次の項目を指定します。

• [Syslog Colors]領域では、重大度レベルごとに背景色と前景色を設定し、メッセージ表示
をカスタマイズできます。[Severity]カラムには、各重大度レベルが名前および番号ごとに
表示されます。各重大度レベルでメッセージの背景色または前景色を変更するには、対応

するカラムをクリックします。[Pick a Color]ダイアログボックスが表示されます。次のい
ずれかのタブをクリックします。

• [Swatches]タブでパレットから色を選択し、[OK]をクリックします。

• [HSB]タブで H、S、Bの設定を指定し、[OK]をクリックします。

• [RGB]タブで赤、緑、青の設定を指定し、[OK]をクリックします。

•冗長なsyslogメッセージをディセーブルにするよう警告するメッセージの表示をイネーブ
ルにするには、[NetFlow]領域で [Warn to disable redundant syslog messages when NetFlow
action is first applied to the global service policy rule]チェックボックスをオンにします。

ステップ 6 これら 3つのタブの設定を指定した後で、[OK]をクリックして設定を保存し、[Preferences]ダ
イアログボックスを閉じます。

プリファレンス設定をオンまたはオフにするたびに、変更内容は .confファイルに保
存され、その時点でワークステーション上で実行中のその他の ASDMセッションか
ら利用できるようになります。すべての変更を有効にするには、ASDMを再起動する
必要があります。

（注）

ASDM Assistantでの検索
ASDM Assistantツールでは、タスクに応じた ASDMの使用方法のヘルプを検索し、表示でき
ます。
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情報にアクセスするには [View] > [ASDMAssistant] > [HowDo I?]の順に選択するか、メニュー
バーの [Look For]フィールドから検索要求を入力します。[Find]ドロップダウンリストから
[How Do I?]を選択して検索を開始します。

ASDM Assistantを表示するには、次の手順を実行します。

手順

ステップ 1 [View] > [ASDM Assistant]を選択します。

[ASDM Assistant]ペインが表示されます。

ステップ 2 [Search]フィールドに検索する情報を入力して [Go]をクリックします。

要求された情報が [Search Results]ペインに表示されます。

ステップ 3 [Search Results]セクションおよび [Features]セクションに表示される任意のリンクをクリック
し、詳細情報を入手します。

履歴メトリックの有効化
[History Metrics]ペインでは、さまざまな統計情報の履歴を保存するように ASAを設定でき、
ASDMを使用してそれをグラフやテーブルに表示できます。履歴メトリックをイネーブルにし
ない場合、監視できるのはリアルタイムの統計情報だけです。履歴メトリックをイネーブルに

すると、直前の 10分間、60分間、12時間、5日間の統計グラフを表示できます。

履歴メトリックを設定するには、次の手順を実行します。

手順

ステップ 1 [Configuration] > [Device Management] > [Advanced] > [History Metrics]を選択します。

[History Metrics]ペインが表示されます。

ステップ 2 [ASDM History Metrics]チェックボックスをオンにして履歴メトリックをイネーブルにし、
[Apply]をクリックします。

サポートされていないコマンド
ASAで使用可能なコマンドはほとんどすべて ASDMでサポートされますが、既存のコンフィ
ギュレーションのコマンドの一部はで無視される場合があります。これらのコマンドのほとん
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どはコンフィギュレーションに残すことができます。詳細については、[Tools]>[ShowCommands
Ignored by ASDM on Device]を参照してください。

無視される表示専用コマンド

次の表に、CLI経由で追加された場合に ASDMのコンフィギュレーションでサポートされる
が、ASDMで追加または編集できないコマンドの一覧を示します。ASDMで無視されるコマ
ンドは ASDMの GUIに一切表示されません。表示専用コマンドは GUIに表示されますが、編
集はできません。

表 5 :サポートされていないコマンドの一覧

ASDMの動作サポートされていないコマンド

無視されます。capture

無視されます。これは、CLIを使用してのみ設定でき
ます。

coredump

無視されます。crypto engine large-mod-accel

ASDMでは、すべての DHCPサーバに対して 1つの
設定のみが許可されます。

dhcp-server（トンネルグループ名一
般属性）

サポート対象外eject

無視されます。established

無視されます。failover timeout

無視されます。fips

無視されます。nat-assigned-to-public-ip

無視されます。pager

無視されます。ASDMでは [List]オプションだけ設定
可。

pim accept-register route-map

matchaccess-listクラスで使用されている場合は無視。
次に例を示します。

access-list myacl extended permit ip any any
class-map mycm
match access-list myacl

policy-map mypm
class mycm
inspect ftp

service-policy mypm global

service-policy global

無視されます。set metric
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ASDMの動作サポートされていないコマンド

無視されます。sysopt nodnsalias

無視されます。sysopt uauth allow-http-cache

無視されます。terminal

無視されます。threat-detection rate

サポートされていないコマンドの影響

既存の実行コンフィギュレーションを ASDMにロードした場合、そこにサポート対象外のコ
マンドがあっても、ASDMの操作には影響しません。サポート対象外のコマンドを表示するに
は、[Tools] > [Show Commands Ignored by ASDM on Device]を選択します。

サポート対象外の連続していないサブネットマスク

ASDMでは、255.255.0.255のように連続していないサブネットマスクはサポートされていま
せん。たとえば、次は使用できません。

ip address inside 192.168.2.1 255.255.0.255

ASDM CLIツールでサポートされていないインタラクティブユーザコ
マンド

ASDM CLIツールは、インタラクティブユーザコマンドをサポートしていません。インタラ
クティブな確認を必要とする CLIコマンドを入力すると、「[yes/no]」の入力を要求するプロ
ンプトが表示されますが、入力内容は認識されません。続いて ASDMは、応答の待機をタイ
ムアウトします。

次に例を示します。

1. [Tools] > [Command Line Interface]を選択します。

2. crypto key generate rsaコマンドを入力します。

デフォルトの 1024ビット RSAキーが生成されます。

3. crypto key generate rsaコマンドを再度入力します。

以前の RSAキーを上書きして再生成するのではなく、次のエラーが表示されます。

Do you really want to replace them? [yes/no]:WARNING: You already have
RSA ke0000000000000$A key
Input line must be less than 16 characters in length.
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%Please answer 'yes' or 'no'.
Do you really want to replace them [yes/no]:

%ERROR: Timed out waiting for a response.
ERROR: Failed to create new RSA keys names <Default-RSA-key>

回避策：

• [ASDM]ペインから、ユーザ介入が必要なほとんどのコマンドを設定できます。

• noconfirmオプションがあるCLIコマンドについては、CLIコマンド入力時にこのオプショ
ンを使用します。次に例を示します。

crypto key generate rsa noconfirm
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